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Chapter

Introduction to Access Permissions

Overview

This manual is intended for system administrators who are responsible for controlling user access to SL1 systems.
This manual describes the access permissions system used in SL1. This system comprises a selection of Access
Hooks that control individual actions and user-defined Access Keys, that group together Access Hooks and are
granted to users. This manual includes step-by-step instructions on how to create Access Keys and how to select
appropriate Access Hooks.

Use the following menu options to navigate the SL1 user interface:

« To view a pop-out list of menu options, click the menu icon ([&).

» Toview a page containing all the menu options, click the Advanced menu icon ( «+ ).
This chapter includes the following topics:

What is an Access HOOK S . 4
WHhat is AN ACCess KOy 2 4

Other Restrictions on User Access



What is an Access Hook?

An Access Hook controls access to a specific action that can be performed in the user interface for SL1. These
actions include navigating to a page, viewing information about an entity in the system, and editing entities in the
system. Each Access Hook is designed to be highly granular, providing access to only one action on one specific
entity or page. Access Hooks are not granted to users directly; instead Access Hooks are grouped together to
form an Access Key, which can be granted to a user.

What is an Access Key?

Because there are several hundred Access Hooks provided in SL1, granting each individual Access Hook to a
user or user policy would be a time-consuming process. Therefore, SL1 requires that Access Hooks be grouped
together in an Access Key that can be granted to users either directly or through a user policy. By default, the
Access Key "Grant All" is included with SL1. Every Access Hook, except for the Access Hook that controls the
Access Key Manager, is aligned to the "Grant All' Access Key. SL1 also includes default Access Keys for the most
common user profiles and common tasks in SL1.

Other Restrictions on User Access

In addition to the Access Hook and Access Key system, user access to SL1 systems is also controlled by
organization memberships and the user type hierarchy.

Access Hooks and Access Keys control the pages users can navigate to and the actions they can perform;
however, user access is further controlled by organization membership. Users can view and interact only with
entities associated with organizations they have membership to. For example, a system might have three
organizations, Org A, Org B, and Org C. If user is a member of Org A and Org B and has access to the Device
Manager page or Devices page, the user will see only devices in Org A and Org B in the Device Manager
page or Devices page. The user will not be able to see or interact with entities associated with Org C.

If a user is able to view the Access Hooks and Access Keys pages, the user interface is restricted so no
navigation links are given to those pages. See the Navigation Access Hooks section for more information.

If a user is able to modify user accounts, user hierarchy is also enforced in the following ways:

» Users of type "user" cannot modify administrator accounts.
» Users of type "user" cannot make themselves or another user an administrator.

* Users cannot grant or remove Access Keys that they have not been granted.

4 What is an Access Hook?



Chapter

Creating and Managing Access Keys

Overview

This chapter describes the layout and functionality of the Access Keys and Access Hooks pages, and includes
step-by-step instructions on how to create an Access Key.

Use the following menu options to navigate the SL1 user interface:
« To view a pop-out list of menu options, click the menu icon [E).

« Toview a page containing all the menu options, click the Advanced menu icon ( === ).

This chapter includes the following topics:

The Access HOOkS Page ... ... 6
Viewing the List of Access HOOKs ... . . . 6
The Access Keys Page ... 7
Viewing the List of Access Keys ... 7
Default Access Keys ... 8
Creating an Access Key .. . . 15
Editing an Access Key ... 16
Deleting Access Keys ... . 17



The Access Hooks Page

To navigate to the Access Hooks page, go to System > Manage > Access Hooks:

[Access Hooks | Access Hooks Found [513] TreeRss sen e
) . 7 R
c l l ) ( )
1 - TICKET_REPORTS TICKET_REPORTS @1  TICKET_REPORTS
2. Application management; APP_COMP_EDIT ApplicationComponentEdit @1 Edtan appiication component
3. Application management: APP_TOPO_ELEW_TYPE_REMOVE TopalogyElementiypeRem 81 Romoveatopologyclementtpe
4 Application management; APP_PGRP_ADD ProcessGroupAdd @1 Adaaproess goup
5 Applicaion management: APP_PGRP_TEWPLATE_ADD ProcessGroupTemplateAdd @1 Addaprocess grouptempate
5. Applicaion management: APP_PGRP_TEWPLATE_VIEW ProcessGroupTemplteviow @1 Resdacoess forprocess group tamplates
7. Applcation managementAPP_TOPO_ELEW_EDIT ToplogyEtementEat ®1  Edtantopologyelement
8. Application managementAPP_COHP_ADD ApplicationComponentAdd @1 Addan appiication component
9. Application management ; APP_TOPO_ELEM_TYPE_EDIT TopologyElementType-Edit @1 Edit an topology element type
10. Application management: APP_COMP_VIEW ApplicationComponentView @1 Readaccess for application components
11 Application management APP_TOPO_ELEM_VIEW ToplogyElementuiew @1 Readaccess fortopalogy elements
12. Appication management APP_PGRP_REMOVE Process GroupRem @1 Removeaprocess group
13 Application management: APP_PGRP_TEMPLATE_RENOVE ProcessGraupTemplteRem @1 Romove s process grouptampiste
14 Applcaion management APP_TOPO_ELEN_ADD ToplogyEtementAdd @1 Addatopologysement
15. Application management  APP_TOPO_ELEM_TYPE_ADD TopologyElementType:Add @1 Addatopology elementtype
16. Application management: APP_COMP_REMOVE ApplicationComponentRem @1 Remove an appiication component
17. Application management APP_TOPO_ELEM_TYPE_VIEW Topologylementiypeview 81 Readaccess forlopology clementtpes
16, Application management APP_PGRP_EDIT ProcessGroupEat @1 Edtanprocess group
15, Appllcation management APP_PGRP_TEMPLATE_EOIT ProcessGroupTemplte it @1 Edtanprocess grouptemplate
20. Application managerment: APP_PGRP_VIEW ProcassGroupview @1 Readaccess forprocess goups
21. Appicatio management: APP_TOPO_ELEW_REWOVE ToplogyElementRem @1 Remove atopologyslamert
2 Assethanagement  AST_EOIT posetEait P A —
23 Assetlanagement  AST_VIEW Assetview 85 Readaccesstoassetrecoris
24 Assetilanagement  AST_ADD Assetada 82 Adsanassetrecord
25 Assetilanagement  AST_ReM AssetRemove 82 Removeanassetrecord
25 Assetllanagement  AST_REG_PAGE RedisiysAssets-ianager @3 Viewthe Assetanager egisty page
27. Business Senices B2 PRODUCT_CATALOG_ORG_VIEW ProductCatlog View From Org Page @1 Viewa productcataog dta fomthe Org propertes page

Viewing the List of Access Hooks

The Access Hooks page displays a list of all Access Hooks in SL1. For each Access Hook, the page displays the
following:

TIP: To sort the list of access hooks, click on a column heading. The list will be sorted by the column value, in
ascending order. To sort by descending order, click the column heading again.

¢ Category. Functional category assigned to the Access Key.

o ID. Alphabetic ID that describes the access hook. These IDs have a uniform format. The first part of the ID
(up to the first underscore character) describes the functional area in SL1. For example "AST " stands for
Asset Management and "DASH" stands for dashboards. The remaining parts of the ID further describe the
location in SL1 and the actions allowed with the Access Hook. For example "CRED SNMP_ADDREM"
means that the Access Hook affects credentials, specifically SNMP credentials, and allows the user to add
and remove SNMP credentials.

¢ Name. Name of the Access Hook.

6 The Access Hooks Page



o # Aligned Keys. Number of Access Keys that the Access Hook is aligned to. Clicking on the padlock icon (

izl) displays the Access Key Alignment modal page, which displays the list of aligned Access Keys for this
hook.

¢ Description. Description of the Access Hook.

NOTE: By default, the cursor is placed in the first Filter-While-You-Type field. You can use the <Tab> key or
your mouse to move your cursor through the fields.

The Access Keys Page

To navigate to the Access Keys page, go to System > Manage > Access Keys:

Access Keys | Access Keys Found [31] TRIAL LICENSE: 57 DAYS REMAINING
~
Name -
( I ]
1. Admin Portal Ul Access SYSTEM 1 6 Grants access to the EW7 web interface
2. Asset-Administration ASSET 1 2 Grants create, edit, and remove permissions for asset records.
3. B Asset-View ASSET 1 2 Grants view access to asset records
4. 2 BasicUser Privileges SYSTEM 1 6 Grants access to the finder, inbox, and preferences tab
5. # Dashboard - Administration DASH 1 2 Grants create, edit, and remove permissions for dashboards
6. Dashboard - View DASH 1 2 Grants view access to shared dashboards.
7. & Dashboard - Widget Developer DASH 1 1 Grants create and edit permissions for dashboards and permission to create and edit widget definitions.
8. Devices - Administration DEVICES -1 Grants view, edit, and delete permissions for devices, device groups, device templates, monitoring policies, and interfaces.
9. Devices - Information View DEVICES - 2 Grants view access to device configuration, performance data, and events:
10. 4B Devices - Operator Access DEVIGES - 2 Grants view access to all information associated with a device and allows a user to run device tooloox commands
1. BEvents - Advanced EVENTS - 2 Grants view, acknowledge, and clear access to events.
12 2 Events - View EVENTS -1 Grants view and acknawledge access o events
13 # GrantAl SYSTEM 1 1 Grant all aceess rights that are allowable for Users (non-Administrators)
14, Bintertaces -View DEVICES - ~  Grants view access to interfaces [m]
15. 1T Senvices - Administration s -1 Grants add, edit, and remove permissions for IT Senvices and IT Senvice Dashboards:
16, JIT Services - View ms - 2 Grants view access to IT Senvices.
17. #Knowledge Base - Administration KB - 2 Grants add, edit, remove permissions for knowledge base articles
18. 2 Knowledge Base - View KB - 2 Grants view access to the knowledge base
19, # Monitors - View DEVICES - ~  Grants view access to monitors. [m]
20 2 Org/ UserVendor / Contact - Administration ORG 1 1 Grants add, edit, and remove permissions for arganizations, user accounts, external contacts, and vendors,
21 # Org 1 User/Vendor / Gontact - Operator ORG -1 Grants view access to organizations, user accounts, external contacts, and vendors, and the ability o add and edit arganization and vendor notes:
22. #0rg/User)Vendor ] Contact- View ORG 1 2 Grants view access to organizations, user accounts, external contacts, and vendors
23. # PowerPack Administration SYSTEM -1 Grants create, edit, and import permissions for PowerPacks.
24, B Provisioning Access SYSTEM -1 Grants add, edit, and remove permissions for credentials and allows a user to run discovery sessions.
25 B Reporting - Administration REPORTS - 2 Grants permissions to run and schedule reports as any user and view archived reports.
26. 2 Reporting - Developer REPORTS -1 Grants edit permissions for report definitions v
TekctAcior] =
opyright ® 2003 - 2019 ScienceLogic, Inc. Al rights reserved

Viewing the List of Access Keys

The Access Keys page displays a list of all Access Keys that have been created. For each Access Key, the page
displays the following:

TIP: To sort the list of Access Keys, click on a column heading. The list will be sorted by the column value, in
ascending order. To sort by descending order, click the column heading again.

The Access Keys Page



o Name. Name of the access key.

o Category. Functional category assigned to the key.

o # Aligned Users. Number of user accounts that have been granted this key.

o # Aligned Policies. Number of user policies that have been granted this key.

o Description. Description of the access key.

NOTE: By default, the cursor is placed in the first Filter-While-You-Type field. You can use the <Tab> key or
your mouse to move your cursor through the fields.

Default Access Keys

SL1 includes default Access Keys to use with the most common user profiles and the most common tasks in SL1.
These default Access Keys are intended as a starting point for administrators to develop a set of access keys that
meet their needs. You can edit the default Access Keys; the default Access Keys excluding Grant All are not

modified when a system is updated with the latest software. The Grant All key is always updated to include all
Access Hooks excluding "Key Manager"

You can use the default Access Keys and user policies to assign groups of users the appropriate Access Keys. For

details on user policies, see the manual Organizations and Users.

You are not required to use the default access keys.

Access Key

Asset - View

Description

Allows users to view asset
records.

Aligned Access Hooks

Asset:View
Registry>Assets>Manager
Registry>

Useful For

Customers

Help Desk
Other staff who
require view-only
access to Asset
Records

Asset - Administration

Allows users to create, edit,
and delete asset records.

Asset:Add

Asset:Edit

Asset:Remove

Asset:View
Registry>Assets>Manager
Custom Select Objects:Asset

Network Engineers
System
Administrators

NOC Staff

Provisioning Staff

Add/Edit/Delete Supporf Engineers
Regisiry> Implementation
Engineers
QA Analysts
Dashboard - Allows users to create, edit, | Dash:Add/Rem Network Engineers
Administration and delete dashboards. Bgz:éjﬁ/liem Shared System
Dosh;EdiT Shared Administrators
Dash:Share NOC Staff
Dash:View

Dash:View Shared
Dash:Widget:Add/Rem
Dash:Widget:Edit

Provisioning Staff
Support Engineers
Implementation

Default Access Keys



Access Key

Description

Aligned Access Hooks

Useful For

Engineers

QA Analysts

Dashboard - View

Grants view access to

shared dashboards

Dash:View
Dash:View Shared

Customers

Help Desk
Other staff who
require view-only
access to
Dashboards

Dashboard - Widget
Developer

Grants create and edit
permissions for
dashboards and
permission to create and
edit widget definitions

Dash:Add/Rem

Dash:Edit

Dash:Share

Dash:View

Dash:View Shared
Dash:Widget:Add/Rem
Dash:Widget:Edit

System > Customize>Dashboard
Widgets

Content Developers

Devices - Information View

Grants view access to device
configuration, performance data,
and device events.

Dev:Events Summary

Dev:IF Graphs

Dev:Performance Graphs

Dev:View Profile

Dev:View Summary
Registry>Devices>Device Manager
Registry>

Customers

Help Desk

Other staff who
require view-only
access to Devices

Devices - Operator Access

Grants view access to all
information associated
with a device and allows a
user to run device toolbox
commands

Dev:Collections
Dev:Events Summary
Dev:IF Graphs
Dev:Interfaces
Dev:Logs

Dev:Monitors
Dev:Notes
Dev:Performance Graphs
Dev:Process View
Dev:Remove
Dev:Schedule
Dev:Thresholds
Dev:Tickets

Dev:Tools
Dev:Tools:ARIN Whois
Dev:Tools:ARP Lookup
Dev:Tools:ARP Ping
Dev:Tools:Deep Port Scan
Dev:Tools:FTP
Dev:Tools:Forward DIG
Dev:Tools:Ping Tool
Dev:Tools:Port Scan
Dev:Tools:Reverse DIG
Dev:Tools:SNMP Dump
Dev:Tools:SNMP Walker
Dev:Tools:SSH
Dev:Tools:Secure Web
Dev:Tools:Telnet
Dev:Tools:Terminal
Dev:Tools:Traceroute
Dev:Tools:Web
Dev:Tools:Web Policy
Dev:Topology
Dev:View

Dev:View Details

Network Engineers

NOC Staff

Default Access Keys




Access Key

Description

Aligned Access Hooks

Dev:View Profile

Dev:View Services

Dev:View Summary
Registry>Devices>Device Components
Registry>Devices>Device Manager
Registry>Devices>Hardware
Registry>Devices>Processes
Registry>Devices>Services
Registry>Devices>Software
Registry>Devices>Device Relationships

Useful For

Devices - Administration

Grants view, edit, and
delete permissions for
devices, device groups,
device templates,
monitoring policies, and
interfaces

DevGroup:Add/Rem
DevGroup:Edit
DevGroup:View
Registry>Devices>Groups
Dev:Collections

Dev:Edit

Dev:Edit Class
Dev:Events Summary
Dev:IF Graphs
Dev:Interfaces

Dev:Logs

Dev:Monitors

Dev:Notes
Dev:Performance Graphs
Dev:Process View

Provisioning Staff
Support Engineers
Implementation

Engineers
QA Analysts

Devices - Administration
(continued)

Dev:Redirects

Dev:Remove

Dev:Schedule
Dev:Template:Add/Remove
Dev:Template:Edit
Dev:Template:View
Dev:Thresholds
Dev:Thresholds:Dynamic App
Dev:Thresholds:Retention
Dev:Tickets

Dev:Tools

Dev:Tools:ARIN Whois
Dev:Tools:ARP Lookup
Dev:Tools:ARP Ping
Dev:Tools:Deep Port Scan
Dev:Tools:FTP
Dev:Tools:Forward DIG
Dev:Tools:Ping Tool
Dev:Tools:Port Scan
Dev:Tools:Reverse DIG
Dev:Tools:SNMP Dump
Dev:Tools:SNMP Walker
Dev:Tools:SSH
Dev:Tools:Secure Web
Dev:Tools:Telnet
Dev:Tools:Terminal
Dev:Tools:Traceroute
Dev:Tools:Web
Dev:Tools:Web Policy
Dev:Topology

Dev:View

Dev:View Details

Dev:View Profile

Dev:View Services
Dev:View Summary
Registry>Devices>Device Components
Registry>Devices>Device Manager

Default Access Keys



Access Key

Description

Aligned Access Hooks

Registry>Devices>Hardware
Processes Registry>Devices>
Registry>Devices>Services
Registry>Devices>Software
Registry>Devices>Templates
Registry>Devices>Device Relationships
Registry>

Networks:Interfaces:Edit
Networks:Interfaces:View
Registry>Networks>Interfaces
Monitor:Add/Rem

Monitors:Edit
Registry>Monitors>Domain Name
Registry>Monitors>Email Round-Trip
Registry>Monitors>SOAP-XML
Registry>Monitors>SSL Certificates
Registry>Monitors>System Processes
Registry>Monitors>TCP-IP Ports
Registry>Monitors>Web Content
Registry>Monitors>Windows Services

Useful For

Grant All

Grant all access rights that
are allowable for Users
(non-Administrators),
excluding the ability to edit
Access Keys

All Key Hooks except Key Manager

Sciencelogic
Administrators

Basic User Privileges

Grants access to the finder
inbox and preferences tab

Finder

Inbox

Preferences>
Preferences>Account>Information
Preferences>Account>Preferences
Preferences>Account>Schedule

All users

PowerPack Administration

Grants create edit and
import permissions for

PowerPack:Create
PowerPack:Delete
PowerPack:Edit

Content Developers
Provisioning Staff

PowerPacks PowerPack:Import Implementation
System > Engineers
System>Manage >PowerPacks
Provisioning Access Grants add, edit, and Cred:Basic:Add/Rem Provisioning Staff

remove permissions for
credentials and allows a

Cred:Basic:Edit
Cred:DB:Add/Rem
Cred:DB:Edit

Support Engineers
Implementation

user to run discovery Cred:SNMP:Add/Rem Engineers
. Cred:SNMP:Edit QA Ano|y5fs
SeSSIoNS Cred:SOAP:Add/Rem
Cred:SOAP:Edit
System>Manage>Credentials
Discovery:Run
System>
System>Manage > Discovery
Admin Portal Ul Access Grants access to the Admin Portal Access All users
Sciencelogic web interface
Events - View Grants view and Event:Acknowledge Customers
acknowledge access to Event:Kiosk . Help Desk
Event:View (From Dev Properties)
events Other staff who

Event:View (From Org Page
Events/Event:View

require view-only
access to Events

Default Access Keys




Access Key

Events - Advanced

Description

Grants view acknowledge

Aligned Access Hooks

Event:Acknowledge

Useful For

Network Engineers

and clear access to events | Evem:Clear NOC Staff
Event:Kiosk
Event:Reacknowledge
Event:View (From Org Page
Events/Event:View
IT Services - View Grants view access to [T Regisfry> Customers
. IT Service:View .
Services Registry>IT Services>IT Service Network Engineers
M System
anager
Administrators
NOC Staff

IT Services - Administration

Grants add edit and
remove permissions for IT
Services and IT Service

Registry>

IT Service Dashboard:Add/Rem
IT Service Dashboard:Edit

IT Service:Add/Rem

Provisioning Staff
Support Engineers
Implementation

Dashboards IT Service:Edit Engineers
IT Service:View QA Anolysts
Registry>IT Services>IT Service
Dashboards
Registry>IT Services>IT Service
Manager
Org / User / Vendor - View | Grants view access to Org:Logs:view Customers
organizations, user Org:Note:View Help Desk
Org:Print Report
accounts, external Org:View Other staff who
contacts, and vendors Org:View summary require view-only
Registry>Accounts>Organizations access to

Registry>Accounts>User Accounts
Registry>Accounts>Vendors
User:Print Report

User:View

Vendor:Notes

Vendor View

Organizations,
Users, and Vendors

Org / User / Vendor -
Administration

Grants add, edit, and
remove permissions for
organizations, user
accounts, external
contacts, and vendors

Custom Select Objects:Organization
Add/Edit/Delete

Custom Select Objects:User Account
Add/Edit/Delete

Org:AddRem

Org:AltLocations:Edit

Org:Edit

Org:Logs:Clear

Org:Logs:View

Org:Notes:Add/Rem
Org:Noftes:Edit

Org:Notes:View

Org:Print Report

Org:View

Org:View Summary
Registry>Accounts>COrganization
External Contact:Add/Rem

External Contact:Edit

External Contact:View

External Contact:View (From Org Page)
Registry>Accounts>External Contacts
Registry>Accounts>User Accounts
Registry>Accounts>Vendors
User:Add/Rem

User:Edit

User:Edit (From Org Page)
User:Print Report

Provisioning Staff
Support Engineers
Implementation
Engineers

QA Analysts

Default Access Keys




Access Key

Description

Aligned Access Hooks

User:View
Vendor:Add/Rem
Vendor:Edit
Vendor:Edit Notes
Vendor:Notes
Vendor:View

Useful For

Org / User / Vendor -
Operator

Grants view access to
organizations, user
accounts, external
contacts, and vendors and
the ability to add and edit
organization and vendor
notes

Org:Logs:View
Org:Notes:Add/Rem
Org:Noftes:Edit

Org:Notes:View

Org:Print Report

Org:View

Org:View Summary
Registry>Accounts>COrganization
Registry>Accounts>User Accounts
Registry>Accounts>Vendors
User:Print Report

User:View

Vendor:Edit Notes

Vendor:Notes

Vendor:View

Sciencelogic
Administrators
Network Engineers
System
Administrators

NOC Staff

Reporting - Run Quick
Reports

Grants permissions to run
quick reports

Reports>
Reports>Create Report>Quick Report

Customers

Help Desk
Other staff who
require view-only
access to Quick
Reports

Reporting - Administration

Grants permissions fo run
and schedule reports as
any user and view archived
reports

Reports:Jobs:Add/Rem
Reports:Jobs:Edit

Reports:Jobs:Run As Any User
Reports:Jobs:Run As Org User
Reports:Schedule

Reports>

Reports>Create Report>Archived
Reports

Reports>Create Report>Quick Report
Reports>Create Report>Report Jobs

Network Engineers
NOC Staff
Provisioning Staff
Support Engineers
Implementation

Engineers
QA Analysts

Reporting - Developer

Grants edit permissions for
report definitions

Reports>
Reports>Management>Input Forms
Reports>Management>Report
Manager
Reports>Management>Report Output
Media

Reports>Management>Report Output
Styles

Reports>Management>Report Output
Templates

Content Developers
Report Developers

Ticketing - End User

Grants basic view and
create permissions for
tickets and allows a user to
add notes to a ticket

Ticket:All in Orgs
Ticket:Assign within Queue
Ticket:Create
Ticket:Edit
Ticket:History (per Org)
Ticket:History:View
Ticket:Messaging
Ticket:Notes:Add
Ticket:Reports
Ticket:Statistics:View
Ticketing/Ticket:View

Customers

Help Desk

Other staff who need
to create tickets and
view tickets only

Default Access Keys




Access Key

Ticketing - Operator

Description

Grants create view and
edit permissions for
ticketing

Aligned Access Hooks

Ticket:Alignment
Ticket:All in Orgs
Ticket:Assign
Ticket:Change Severity
Ticket:Clipboard
Ticket:Create
Ticket:Edit
Ticket:History (per Org)
Ticket:History: View
Ticket:Inbox:Statistics
Ticket:Messaging
Ticket:Notes:Add
Ticket:Notes:Cloaked
Ticket:Notes:Cloaked:Edit
Ticket:Notes:Edit
Ticket:Reports
Ticket:Statistics:View
Ticket:View Logs
Ticket:View Watchers
Ticket:Watchers:Add/Rem
Ticketing/Ticket:View

Useful For

Network Engineers
NOC Staff
Provisioning Staff
Support Engineers
Implementation
Engineers

QA Analysts

Ticketing - Administration

Grants create view and
edit permissions for
ticketing and allows a user
to configure the ticketing
system

Registry>
Registry>Ticketing>Custom States
Registry>Ticketing>Email Tickets
Registry>Ticketing>Escalations
Registry>Ticketing>Queues
Registry>Ticketing>Templates
Ticket:Access All

Ticket:Access All Queues
Ticket:Alignment

Ticket:All queue Members
Ticket:All in Orgs

Ticket:All in queues
Ticket:Assign

Ticket:Assign within Queue
Ticket:Change Severity
Ticket:Charge Back Services
Ticket:Clipboard

Ticket:Create

Ticket: Customize Forms
Ticket:Delete

Ticket:Edit
Ticket:Escalation:Add/Rem
Ticket:Escalation:Edit
Ticket:Events:Alignment
Ticket:History (per Org)
Ticket:History:View
Ticket:Inbox:Statistics
Ticket:Messaging
Ticket:Notes:Add
Ticket:Notes:Cloaked
Ticket:Notes:Cloaked Edit
Ticket:Notes:Edit
Ticket:Notes:Remove
Ticket:Queue:Edit
Ticket:Queue:View
Ticket:Reports
Ticket:Scheduler
Ticket:Statistics:View
Ticket:Templates:Edit/Add/Rem
Ticket:View Any

Ticket:View Logs

Ticket:View Watchers

Provisioning Staff
Support Engineers
Implementation
Engineers

QA Analysts

Default Access Keys



Access Key Description Aligned Access Hooks Useful For

Ticket:Watchers:Add/Rem
Ticketing/Ticket:View
Ticketing:States:Add/Rem
Ticketing:States:Edit

Creating an Access Key

You can create Access Keys on the Key/Hook Alignment Editor page.

To create an Access Key:

1. To navigate to the Access Hooks page, go to System > Manage > Access Keys.

2. Click the [Key Manager] button. The Key/Hook Alignment Editor page appears:

Key/Hook Alignment Editor | Editing new key
Access Keys Key Details
- - y Name Key Category
EMT7 System Ad ation [ ][API e V]
Ticketing
Dashboards Key Description

Asset Management
Knowledge Base
Organizations
Reports Hook Alignment

ned Access Hooks

Aligned Access Hooks
Events

Application management and mapping ~
Devices ApplicationComponent:Add
. ApplicationComponent:Edit

T Servicas ApplicationCompenent:Rem
ApplicationComponent:View
ProcessGroup:Add
ProcessGroup:Edit
ProcessGroup:Rem
ProcessGroup:View a
ProcessGroupTemplate: Add
ProcessGroupTemplate Edit
ProceseGroupTemplate:Rem
ProcessGroupTemplate: View
ToplogyElement:Add

Edit

7

3. Supply a value in each of the following fields in the Key/Hook Alignment Editor page:

o Name. Enter a name in the Name field. This name will be used anywhere a list of Access Keys is
displayed.

o Key Category. Select a category from the Key Category drop down list. Categories are included to
help you organize your access keys. Lists of Access Keys are always displayed grouped by category. In
addition, Access Keys must be in certain Categories if they will be used to control access to
Dashboards, Knowledge Base Articles or Device Groups. For more information, see the Using
Access Keys with User Generated Content section.

: Due to security vulnerabilities, Sciencelogic recommends that customers who installed

SL1 priorto 8.9.2 disable the Knowledge Base. For details, see the release notes for version
8.9.2 of SL1.

Creating an Access Key



« Key Description. Enter a description in the Key Description field. The description is displayed on the
Access Keys page, and is included to help you organize your Access Keys. The description is also
displayed when the mouse is hovered over the Access Key on the Account Permissions and User
Policy Properties Editor pages. The description is optional.

4. Select Access Hooks to align with the Access Key using the list of Unaligned Access Hooks and Aligned
Access Hooks and arrow buttons ([>>], [<<]). Initially, all Access Hooks will be in the list of Unaligned
Access Hooks.

5. To assign an Access Hook to the current Access Key:

« Highlight one or more Access Hooks in the Unaligned list.

« Highlight one or more Access Hooks in the Unaligned list.
6. To move Access Hooks from the current Access Key:

o Highlight one or more Access Hooks in the Aligned select list.

* Click the arrow button that points left ([< <]).
You can select multiple Access Hooks at once:

» To select a range of Access Hooks, click on the first Access Hook, then click on the last Access Hook
while holding down the <Shift> key on your keyboard. The Access Hooks you clicked on and all the
Access Hooks between them in the list will be selected.

 To select several Access Hooks, hold down the CTRL key on your keyboard while clicking on them.
Mac users should hold down the Command key instead of the CTRL key.

* To select every Access Hook in a category, click on the red category name.

7. Select the [Save] button. The message "Save Completed” will be displayed at the top of the screen.

8. Ifyou select the [Save] button again, any changes made will be applied to the same Access Key. Select the
[New] button if you want to create another Access Key.

Editing an Access Key

To edit an Access Key:

1. Navigate to the Access Keys page (System > Manage > Access Keys).
2. Find the Access Key you want to edit. Click the Key Editor icon ( a) for that Access Key. Alternately, if you are
already in the Key/Hook Alignment Editor page, you can select an Access Key to edit from the list of

Access Keys displayed on the left side of the page.

3. When you select an Access Key to edit, all the fields in the Key/Hook Alignment Editor page are
populated with the current data for the Access Key. You can make changes to the values in one or more

fields.

4. After making changes, click the [Save] button to save your changes.
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5. To save your changes as a new Access Key, enter a new value in the Name field and select the [Save As]
button.

6. Clicking the [Reset] button will reload the fields with the last saved data for the Access Key, without saving
any changes from this editing session.

Deleting Access Keys

"Delete Key" is the only option in the Select Action drop down list on the Access Keys page. Perform the
following steps to delete Access Keys:

1. Onthe Access Keys page, click the checkbox () for each Access Key to be deleted.

2. Inthe Select Action drop down list, select Delete Key.

3. Click the [Go] button.

NOTE: You cannot delete an Access Key that is currently granted to a user account or user policy.
Checkboxes will not be displayed for Access Keys that cannot be deleted.
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Chapter

Assigning Access Hooks

Overview

This chapter will help you select the Access Hooks that best fit the needs of your business. Because Access Hooks
are as granular as possible, some Access Hooks have dependencies on other Access Hooks. For example, the
Asset:View Access Hook grants the user access to view a specific asset. However, the user's granted Access Keys
user must also include the Registry>Assets>Manager Access Hook to access the Asset Manager page, and
the Registry> Access Hook to access the [Registry] tab.

This chapter describes the levels of access control, from providing access to the top-level navigation tabs to
performing actions on specific pages.

Use the following menu options to navigate the SL1 user interface:
« To view a pop-out list of menu options, click the menu icon [E&).

« Toview a page containing all the menu options, click the Advanced menu icon ( ++ ).

This chapter includes the following topics:

Access Hooks for Top-Level Navigation ... 19
Navigation Access HOOKs ... 20
Action Access HOOKS ... 21
Action Access Hook Dependencies ...l 22
Blacklisting or Whitelisting Access HOOKS ...l 22

Enabling the Access Hook Blacklist or Whitelist ... 23

Example of the Access Hook Blacklist ... 23



Access Hooks for Top-Level Navigation

To make it easier to determine and select the appropriate Access Hooks, each Access Hook is categorized by
functional area of the product. For example, the Asset Hook Asset:View is in the Asset Management category

Access Hooks use a consistent naming convention to indicate their function, including an entity and action, for
example "Asset:View". The Access Hooks page includes a description of each Access Hook.

If you want to allow users to view each top-level tab in SL1, you must create Access Keys that include the Access
Hooks described in this section. If users do not have any Access Hooks that allow the user to view one or more
top-level tabs, aligned with their granted Access Keys, those users will not see any navigation tabs when they log
into SL1:
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If you want to align an Access Hook for an action with an Access Key and that Access Hooks requires a user to
use the top-level navigation tabs to perform an action, such as allowing them access to a page under a tab, you
must also align the corresponding Access Hook described in this section.

TIP: In certain situations, you might not want to grant users access to the top-level navigation tabs. If users
have access to a page under a tab, but not the corresponding tab, they can still access the page using
a direct link. If you want to restrict user access to the standard top-level navigation tabs, but still want to
allow users to access pages under the tab, you may want to consider custom navigation tabs or
another method of providing users with links to those pages. For information on custom navigation
tabs, see the manual Customizing User Experience.

The following table describes the Access Hooks that allow a user to view top-level navigation tabs. Some of these
Access Hooks also grant users other permissions; these permissions are described in the "Additional Access"
column.
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Tab

Access Hook Category

Access Hook Name

Additional Access

Dashboards | Dashboards Dash:View Allows user to view their own
dashboards. Does not allow user to
create or edit their own dashboards.

Views Views Views: View Allows the user to view the Views tab and
to view the Views that are embedded in
Dashboards.

NOTE: To allow users to view the
Views embedded in
Dashboards but not allow
the user to view the Views
tab, assign the Acces
Hook Views:View
Embedded.

Events Events Events/Event:View Allows user to view the list of events for
their organizations on the Event Console
screen.

Tickets Ticketing Ticketing/Ticket:View | Allows user to view the list of tickets in
their assigned ticket queues for their
organizations on the Ticket Console
page.

Reports Reports Reports> None

Registry EM7 System Administration | Registry> None

System EM7 System Administration | System> None

Preferences User Account Management | Preferences> None

NOTE: For tabs that have a left Navbar or menu bar, such as [Registry] and [System], the top-level
navigation hook will allow the user to select only the tab. On these tabs, links in the left Navbar or
menu bar will appear only if the a user has additional Access Hooks specifically for the links in the
left Navbar or menu bar.

Navigation Access Hooks

Access Hooks that allow users to navigate to pages within the user interface follow a similar naming convention.
The Access Hook name represents the sequence of mouse clicks required to navigate to the page. For example:

Registry>Accounts>User Accounts

Navigation Access Hooks
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In this example, the Access Hook grants access to the User Accounts page. To navigate fo this page a user
would click on the [Registry] tab, then the "Accounts" and "User Accounts" links in the left Navbar or menu bar.

When you assign an Access Key containing a navigation Access Hook, the user is allowed to navigate to and view
the page only. To perform action in the page, such as adding, removing, viewing, and editing entities, the user
must be assigned additional Access Hooks.

The "System>Manage >Access Hooks" and "System>Manage>Access Keys" Access Hooks behave differently
from other navigation Access Hooks. The left Navbar or menu bar links to the Access Hooks and Access Keys
pages are displayed only to accounts of type Administrator. Even if you assign "System>Manage>Access Hooks"
and "System>Manage>Access Keys' to a user, the user will not see the Access Hooks and Access Keys links.
However, the user will be able to navigate to the Access Hooks and Access Keys pages by going directly to the
URL of those pages.

NOTE: All Access Hooks that control navigation to specific pages are dependent on Access Hooks
described in the Access Hooks for top-level navigation section. If you want to allow a user to
navigate to a page that is controlled by a navigation key, you must grant that user the top-level
navigation Access Hook and the navigation Access Hook.

Action Access Hooks

Access Hooks that allow users to perform an action on or view specific information about an element use a
consistent naming convention. The Access Hook name includes the following information separated by colons:

» The general entity type or area of SL1, e.g. "Ticket" or "Org'".

 [f applicable, the specific part of the entity or area of SL1, e.g. "Watchers" for ticketing, or "Notes" for
organization.

¢ [fthere are multiple actions that can be performed, the specific action that can be taken, e.g. "Add/Rem" or
"Edit". If the action information is not included in an Access Hook name, the Access Hook allows a user to
take any available action on the entity or area of the product.

The following are examples of action Access Hooks:

o Cred:SNMP:Add/Rem. "Cred" indicates that the general entity type is a credential, "SNMP" indicates the

Access Hook applies only to SNMP credentials, and "Add/Rem" indicates the Access Hook allows a user to
add or remove an SNMP credential.

o Dev:Tools. "Dev" indicates that the general entity type is a device and "Tools" indicates the Access Hook
applies only to the Device Toolbox. Because there is no action included in the Access Hook name, when you
grant a user this Access Hook, the user will be able to perform every action available on the Device
Toolbox page.

o Discovery:Run. "Discovery" indicates that the Access Hook applies to the Discovery Manager section, and
'Run" indicates the Access Hook allows a user to schedule or execute a discovery session.

NOTE: In general, separate Access Hooks are provided for adding/removing entities and editing entities.
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Action Access Hook Dependencies

The following dependencies apply to Access Hooks that allow users to perform actions:

* If a user has an Access Hook that allows them to perform an action, you must also grant them access to the
page on which the action is performed. For example, a user who has the "Org:Edit" Access Hook should
also have the "Registry>Accounts>Organizations" Access Hook to navigate to and edit an organization. If
you are noft restricting user access to top-level navigation tabs, you must also grant the user the "Registry>"
Access Hook.

* I|f a user has an Access Hook that allows them to view a tab in a panel separate from the main screen (for
example, the Device Details panel, Device Summary panel, or the Ticket panel), the user should also
have the Access Hook that allows them to view the default tab in the panel. For example, suppose you grant
a user with the "Dev:View IFs" Access Hook, which allows a user to view the Interfaces tab in the Device
Administration panel. You should also grant the user the "Dev:View Details" Access Hook so the user can
access to the Device Properties page, which is the default page in the Device Administration panel.

o Ifa user has an "Access All", or "View Any" Access Hook, the user will still need the corresponding "View"
Access Hook. For example, a user with the "Ticket:Access All' Access Hook must have the "Ticket:View"
Access Hook to view tickets.

Blacklisting or Whitelisting Access Hooks

You can override existing user permissions and Access Keys in SL1 by blacklisting or whitelisting Access Hooks for
all users, administrators, or regular users:

o Blacklisting disables one or more access hooks. You can disables an access hook for all users, users-level
users, administrator-level users, or a combination of user types.

o Whitelisting enables one or more access hooks. You can enable an access hook for all users, users-level
users, administrator-level users, or a combination of user types.

NOTE: Blacklisting Access Hooks using the following method does not disable links to blacklisted pages, but
a user on the black list cannot load blacklisted pages.
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Enabling the Access Hook Blacklist or Whitelist

To enable the Access Hook blacklist or whitelist:

1. Go to the console of the Administration Portal, All-In-One Appliance, or Database Server that provides web
access for your system or use SSH to access the command line.

2. Use vi (or a text editor of your choice) to create the file /etc/.custom_alignment.conf.

3. Configure the permissions for /etc/.custom_alignment.conf to allow nginx to read the file:

chmod a+r /etc/.custom alignment.conf

4. Add one or more of the following sections to the file; add only the sections that will include at least one
blacklist or whitelist rule:

[ALL]. Blacklist or whitelist Access Hooks for all users
[USER]. Blacklist or whitelist Access Hooks for all regular users

[ADMIN]. Blacklist or whitelist Access Hooks for all administrator users

5. Add the hooks that you want to add to your black list or white list:

To blacklist an Access Hook, add the following line to the appropriate section, substituting the Access
Hook ID where indicated:

<access _hook_ ID>=deny

where access_hook_ID is the alphabetic ID that describes the Access Hook. For example, the
following code prevents users from viewing passwords in plaintext:

CRED VIEW PASSWORD=deny

To whitelist an Access Hook:

<access hook ID>=allow

5. Go to the Cache Management page (System > Tools > Cache) and delete all cache entries.

Example of the Access Hook Blacklist

Requirement: Make the Database Tool page (System > Tools > DB Tool) inaccessible to all users.

Process: Update /etc/.custom_alignment.conf with the following:

[ALL]

SYS TOOLS DB=deny
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Chapter

Using Access Keys with User-generated
Content

Overview

You can use Access Keys to restrict access to user-defined content, specifically dashboards and device groups.
Each dashboard or device group can have an associated Access Key that controls user access. The following
sections describe how to use Access Keys with each type of content.

TIP: You can create dedicated Access Keys that provide access only to user-defined, shared content by
creating an Access Key without any aligned Access Hooks.

Use the following menu options to navigate the SL1 user interface:

« To view a pop-out list of menu options, click the menu icon [E&).

« Toview a page containing all the menu options, click the Advanced menu icon ( ++ ).

This chapter includes the following topics:

Using Access Keys with Dashboards ... 25
Using Access Keys with Device GroUps ... 26
Generating a Report for an Access Key ... 28

24



Using Access Keys with Dashboards

To share a classic dashboard with users, you must configure the Access Control for the dashboard to permit other

organizations to use it.

To edit a classic dashboard:

—_

Open the dashboard you want to configure on the Dashboards tab.

Click [Actions] and select Configure Dashboard. The Dashboard Settings modal opens.

2
3. Set Access Control to Share with organizations.
4

Select one or more Access Keys to grant access to the dashboard as needed.

NOTE: For more information on dashboards, see the Dashboards manual.

Dashboard Seftings x

Dashboard Title Access Control

[P.CI Application Dashboard ] [F'rivate dashboard

v

Minimum Size (current: 1114x584) Access Keys

Liguid Width Liguid Height EMT System Administration
i ] Basic User Privileges
Fixed Margins

) PowerPack Administration
Left: 40 Right: 20 Top: 30 Bottom: O Provisioning Access

Lock dashboard layout Admin Portal Ul Access
M di t bord Subscription Management
erge adjacen ers

Show in Dashboards drop-down
|:| Show widget debug messages
Category

Sciencelogic

Asset Management
Cisco
Cloud

Keywords (comma separated)

Save

When you define the dashboard as shared, the Access Keys field will become active. Access Keys in the "EM7
System Administration" and "Dashboards" categories will appear in the Required Keys select field. You can select

any number of keys from the Required Keys select field.

A user must meet the following criteria to use a dashboard controlled by an Access Key:

25
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o The user must have at least one of the Access Keys selected in the Required Keys select field for the
Dashboard. If no Access Keys are selected, any user meeting the following two requirements may access the

dashboard.

» The user must be granted an Access Key that includes the "Dash:View" and "Dash:View Shared" Access
Hooks.

* The user and the creator of the Dashboard must be members of the same organization.

If a user meets the above requirements and also has been granted an Access Key that includes
the "Dash:Edit Shared" Access Hook, that user will be able to edit the shared Dashboard. If a

user has been granted an Access Key that includes the "Dash:Add/Rem Shared" Access Hook,
that user may delete shared Dashboards.

Using Access Keys with Device Groups

To share a device group with users, you must select the "yes" option in the Shared (visible to all users) radio
button group when creating or editing a device group:

NOTE: For details on device groups, see the manual Device Groups and Device Templates.
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Device Group Editor | Editing group [5]

| wew | Gude | Reset |
Device Group Name Force Child Visibility? Sharing Permissions
[ACIVms ] [ [Yes] v] [ Shared with users in your organizations ] ~ ]
lcon

Visibility

Permission Keys

EM7 System Administration A
Config Policies/Bulk Edit Grant All
Notification/Autemation Basic User Privileges
Discovery PowerPack Administration
|

Device Schedules Provisioning Access
— Event Suppression Admin Portal Ul Access

RSS Feeds Subscription Management
IT Services
IT Services - View
IT Services - Administration N
Static Devices and Groups | Devices [0] | Groups [0] (| Add ]
Device Name - Class | Sub-class D Organization Device Group Name ~ D Devices Groups Rules

No devices in current device group. No sub-groups in current device group.

Dynamic Rules | Rules Found [1]

Selector Type Selector Targets Matched Devs
11 }‘ Device Class Cisco Systems | ACI Endpoint Group 1] D
Devices matched for rule 1: 0
Matched

save As

The Permission Keys select field will become active when "yes" is selected. Access Keys in the "EM7 System

Administration" and "Device Groups" categories will appear in the Permission Keys select field. You can select
any number of keys from the Permission Keys select field.

A user must meet the following criteria to use an Access Key controlled device group:

The user must have at least one of the Access Keys selected in the Permission Keys select field for the device

group. If no Access Keys are selected, any user meeting the following two requirements will be able to
access the device group.

The user must have the Registry> and Registry>Devices>Groups Access Hooks aligned with one of their
granted Access Keys

The user and creator of the device group must be members of the same organization.

CAUTION: If a user has the DevGroup:Edit Access Hook aligned with one of their granted Access Keys in
addition to meeting the above requirements, they will be able to edit the shared device group.
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Generating a Report for an Access Key

From the Access Keys page you can generate a report on any access key in SL1. The report displays the hook
category, hook ID, and hook name of each access hook included in the access key.

Key Alignment Report generated by em7admin on 2015-06-30 11:17:18
Key Name: Agset - View

Category: Asset Management

Description: Grants view access to asset records.

Hook Category: Asset Management

Hook ID

Hook Name

AST_VIEW

Asset:\View

AST_REG_PAGE

Registry>Assets>Manager

Hook Category: EM7 System Administration

Hook ID

Hook Name

SYS_REGISTRY_PAGE

Registry=

To generate a report on access keys:

1. Navigate to the Access Keys page (System > Manage > Access Keys).

2. Locate the access key for which you want to generate a report and click its wrench icon (

&
/

Access Keys | Access Keys Found [31]

27 BReporting - Run Quick Reports

Copyrignt © 2003 - 2013 ScienceLogic, Inc. Al rights reserved

Name - Category
( )

dmin Portal Ul Access SYSTEM 1 6
2. b Asset- Administration ASSET 1 2
3. PAsset-View ASSET 1 2
4. Basic User Privileges SYSTEM 1 6
5. #Dashboard - Administration DASH 1 2
6. Dashboard - View DASH 1 2
7. ##Dashboard - Widget Developer DASH 1 1
8. /& Devices - Administration DEVICES -1
9. Devices - Information View DEVICES - 2
10. @ Devices - Operator Actass DEVICES - 2
1. M Events - Advanced EVENTS - 2
12. BEvents-View EVENTS - 1
13. B GrantAl SYSTEM 1 1

14. Binterfaces - View DEVICES -
15. T Senices - Administration s -1
16. BT Senvices - View s - 2
17. BKnowledge Base - Administration KB - 2
18. #Knowledge Base - View KB - 2

19. B Monitors - View DEVICES -
20. 0rgUser Vendor / Contact - Administrafion ORG 1 1
21. #Org/User |/ Vendor / Contact - Operator ORG -1
22. Org/User I Vendor / Gontact - View ORG 1 2
23, #PowerPack Administration SYSTEM - 1
24. BProvisioning Access SYSTEM -1
25. f#Reporting - Administration REPORTS - 2
26. fReporting - Developer REPORTS - 1
REPORTS - 1

A
( )
Grants access to the EM7 web interface,

Grants create, edit and remove permissions for asset records

Grants view access to asset records.

Grants access to the finder, inbox, and preferences tab

Grants create, edit and remove permissions for dashboards

Grants view access to shared dashboards.

Grants create and edit permissions for dashboards and permission to create and edit widget definitions.

Grants view, edit, and dlste permissions for devices, device groups, devics tsmplates, monilaring policies, and interfaces

Grants view access to device Gonfiguration, performance data, and events.

Grants view access to all information associated with a device and allows 3 Userto run device toolbox commands.

Grants view, acknowledge, and clear access to events.

Grants view and acknowledge access to events

Grant all access rights that are allowable for Users (non-Administrators)

Grants view access o interfaces a
Grants add, edit, and remove permissions for IT Senices and IT Service Dashboards

Grants view access to IT Senvices.

Grants add, edit, remove permissions for knowledge base artiles

Grants view access to the knowledge base

Grants view access to monitors [m]
Grants add, edit, and remove permissions for organizations, user accounts, external contacts, and vendors.

Grants view access to organizations, user accounts, extemal contacts, and vendors, and the abilty to add and edit organization andvendor notes.

Grants view access to organizations, user accounts, extemnal contacts, and vendors

Grants create, edit, and import permissions for PowerPacks.

Grants add, edit, and remove permissions for credentiale and allows 3 user 1o fun discovery sessions.

Grants permissiens fo run and schedule reports as any user and view archived reports.

Grants edit permissions for repart defintions.

Grants permissions ta run quick reports

o e v

3. The Key/Hook Alignment Editor modal page appears. Click the [Report] button:
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28



Key/Hook Alignment Editor | Editing key "Admin Portal Ul Access” New Report Reset

Access Keys Key Details
EM7 System Administration
Grant Al

Name Key Category
| [EM7 System Administration v

[Admin Portal Ul Access

Key Description
(Grants access to the EMT web interface. ‘

Basic User Privileges
PowerPack Administration

Provisioning Access

Admin Portal Ul Access
Subscription Management Hook A“gnmeﬂ
Ticketing Application management and mapping ~ EM7 System Administration

ApplicationCemponent:Add Admin Portal Access
Dashboards
ApplicationCoemponent:Edit

Ealigned Access Hooks Aligned Access Hooks

Aszset Management

Knowledge Base

ApplicationComponent:Rem
ApplicationComponent:View

o ProcessGroup:Add
Organizations ProcessGroup:Edit
Reports ProcessGroup:Rem
ProcessGroup:View »
Events ProcessGroupTemplate: Add
Devices ProcessGroupTemplate:Edit
. ProcessGroupTemplate:Rem
IT Services

ProcessGroupTemplate: View
ToplogyElement: Add
ToplogyElement: Edit
ToplogyElement:Rem
ToplogyElement: View
TopologyElementType:.Add
Tooolo ovElemeniTvpe Edit

L] save | Savess

4. The Export key definition as a report modal page appears:

Export key definition as a report x

QOutput Format: [ Acrobat Document (.pdf) v]

D Force browser to save to disk

Select from the following output formats to generate the report:

* Web page (.html)
* OpenDocument Spreadsheet (.ods)
* Excel Spreadsheet (.xlsx)
* Acrobat Document (.pdf)
5. Click the [Generate] button to generate the report. If you selected the Force browser to save to disk

checkbox on the Export key definition as a report modal page, you will be promoted to designate a
location to save the report before you can view the report.
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Chapter

Best Practices for Access Permissions

Overview

This chapter describes the best practices that Sciencelogic recommends you follow when creating Access Keys.
Although you can completely customize your own Access Keys, the recommendations provided in this section will
make managing Access Keys easier.
Use the following menu options to navigate the SL1 user interface:

« To view a pop-out list of menu options, click the menu icon [&).

« Toview a page containing all the menu options, click the Advanced menu icon ( «+ ).

This chapter includes the following topics:

Best Practices 31
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Best Practices

Sciencelogic recommends you follow these best practices when creating Access Keys:

31

In general, Access Keys should include Access Hooks for one area of the product. It is a good idea to select
a category for an Access Key and then include only Access Hooks from the same category. If you want to
easily grant a user Access Hooks that cover different sections of the product, we recommend you create an
Access Key for each section and then align them with a User Policy.

If you are creating an Access Key that includes Access Hooks with dependencies, you should also align the
Access Hooks they depend on with the Access Key, even if they are in a different category.

To avoid confusion, you shouldn't create too many similar Access Keys. If there is a large overlap between
Access Keys, consider creating an Access Key that only includes the overlapping Access Hooks, then create
additional Access Keys for users that must be granted the non-overlapping Access Hooks.

If you are using Access Keys to control access to user generated content, consider creating Access Keys
without aligned Access Hooks solely for that purpose. If you do this, it is easier to grant and remove access
to dashboards, knowledge base articles, and device groups without affecting a user's granted Access
Hooks.

Due to security vulnerabilities, Sciencelogic recommends that customers who installed SL1 prior
to 8.9.2 disable the Knowledge Base. For details, see the release notes for version 8.9.2 of SL1.
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Appendix

Example: An Access Key to View Assets

Overview

In this example we will create a simple Access Key. We will use the example of a SL1 system used by a service
provider to monitor customer devices. The service provider uses the ticketing features of SL1 to track issues
reported by customers, and also maintains asset records in SL1 for every hardware device monitored. The Access
Key we will design and create is to be granted to the service provider's technical support personnel so they can
access asset information for devices.

Use the following menu options to navigate the SL1 user interface:
« To view a pop-out list of menu options, click the menu icon ([&).

» Toview a page containing all the menu options, click the Advanced menu icon ( «+ ).

This chapter includes the following topics:

Requirements ... .. . . 33
Selecting Access HOOKS ... 33
Checking Access Hook Dependencies ... . ...l 33
Creating the Access Key ... . 34
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Requirements

The service provider has determined their technical support personnel must be able to do the following with
assets:

1. Access the Asset Manager page.

2. View information about an asset.

Although their technical support personnel must be able to view asset information, the service provider does not
want their technical support personnel to add, remove, or edit asset records.

Selecting Access Hooks

If we look at the list of Access Hooks, the following Access Hooks are in the "Asset" category:

* Asset:Add

* Asset:Remove

* Asset:Edit

* Registry>Assets>Manager

o Asset:View
To meet requirement 1, access the Asset Manager page, we will align the "Registry>Assets>Manager" Access
Hook with this Access Key. To meet requirement 2, view information about an asset, we will align the "Asset:View"

Access Hook with this Access Key. We will not align the other three asset Access Hooks to this Access Key so
technical support personnel cannot add, remove, or edit assets.

Checking Access Hook Dependencies

Now we have selected the Access Hooks that allow users to do what we want, we must check if that the selected
Access Hooks have any dependencies on other Access Hooks. We will look at each selected Access Hook in turn:

 Registry>Assets>Manager. This is a navigation Access Hook. As described in the Navigation Access
Hooks section of this manual, all navigation access hooks are dependent on a top-level navigation Access
Hook. In this case, the Asset Manager page is accessed using the [Registry] tab, so the user must also be
granted the "Registry>" Access Hook. The Best Practice for Access Hook dependencies is to align all the
required Access Hooks to the Access Key, so we will include the "Registry>" Access Hook with this Access
Key.

o Asset:View. This is an action Access Hook. As described in the Action Access Hooks section, we must
ensure the user has access to the page on which the action is performed. In this case, the "Asset:View" action
is performed on the Asset Manager. We have already selected Access Hooks that will grant access to the
Asset Manager page, so we do not need to align any other Access Hooks to this Access Key.
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Creating the Access Key

We have now selected the following Access Hooks to be aligned with the Access Key:

¢ Registry>Assets>Manager
e Assetf:View

e Registry>
We will now perform the following steps to create the Access Key:

1. To navigate to the Access Keys page, go to System > Manage > Access Keys.

2. Click the [Key Manager] button to open the Key/Hook Alignment Editor page in create mode:

Key/Hook Alignment Editor | Editing new key mm
Access Keys Key Details
N Key Cati
BHEMT System Administration ame ey Lategory
| | | APl Access EI
[ Ticketing —
[+Dashboards Key Description
[Fas=et Management
[-Knowledge Base
[HOrganizations Hook Alignment
[Reports Unaligned Access Hooks Aligned Access Hooks
[+FEvents Api Access - -
E-Devi APl Resource Indexes [
evices APL: Server Access e

[HT Services Aszset Management

AssetAdd

AssetEdit H

AssetRemove

AssetView

Registry=Assets=Manager

Business Services

Product Catalog:Add/Rem

Product Catalog:Edit

Product Catalog:\View i i

Draduct Catal AV.if From Oro Dana
. save

3. If's preferable to name an Access Key based on what it does, so enter "View Asset Records" in the Name

field.

4. Because this Access Key grants access to Assets, select "Asset Management" from the Key Category drop
down list.

5. The description for a key should give a clear indication of what a user who is granted this Access Key will be
able to do. Although this Access Key is being designed for a specific user, it is a good idea to make the
description as generic as possible to prevent confusion if the Access Key is reused for another purpose. Enter
this description in the Key Description field: "This Access Key allows a user to navigate to the Asset
Manager page and view asset records." The Key Manager should now look like this:
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6. We need to select the Access Hooks to be aligned with the Access Key. Locate the "Asset Management"
section of the Unaligned Access Hooks select list, then click on "Asset:View" and

"Registry>Assets>Manager" while holding down the CTRL key on your keyboard:
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7. Then scroll to the "EM7 System Administration" section of the Unaligned Access Hooks select and click on
"Registry>" while holding down the CTRL key on your keyboard:
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8. Click the right arrow button ([>>]) to move these three Access Hooks to the Aligned Access Hooks select

list:
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9. Click the [Save] button to save the Access Key. The Access Key is now finished and ready to be granted.
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